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Preface, designated use

The UMB Config Tool has been created for configuring, commissioning, maintaining,
calibrating and checking Lufft UMB sensors, modules and systems.

It is not designed for reading out and storing data permanently. For the permanent data
evaluation Lufft offers the software SmartView3.

When in the UMB Config Tool values or ranges of values are shown, and these are different
from those in the device description of the sensor, always the details in the operating manual
for this sensor version counts (see also "channel list update a sensor").

The UMB Config Tool is single seat software. It is not intended that multiple users use this
software from the same directory at the same time.

The UMB Config Tool is able to create logfiles. When these files are opened by other
programs during the operation of the UMB Config Tool, there might occur writing errors (i/o
Errors) when the UMB Config Tool tries to update them, and the file will not update correctly.
Details to special functions for sensors can be found in the operating instructions of the
sensor.

Installation UMB Config Tool

Start ‘Setup_UMB_Config_xxxxxxx.EXE’ and follow the instructions of the installation
programme.

The software is installed under ‘C:\Luff\UMB-Config’ as standard. In MS-Windows Vista and
MS-Windows 7 you must not install the software in the directories C:\Program Files or
C:\Program Files (x86) because these directories are specially protected system directories,
and the protection does not work well with the normal program function of this tool.

Start the application with ‘Start’ > ‘Programme’ - ‘Lufft UMB Config’ - ‘Config Tool'.

Installation paths:

Path Content

..\LufftUMB-Config\ Application and INI files
...\LUfftUMB-Config\Firmware Device firmware (mot files)
...\LufftUMB-Config\Hexload Bootloader programme
..\LufftUMB-Config\UMB_FWUpdate Firmware update program for Marwis-UMB
..\LufftUMB-Config\Konfig Stored device configurations

Copy the current device firmware into the firmware directory prior to installing firmware
updates.

The UMB Config Tool can be uninstalled with ‘... \Lufft\tUMB-Config\UNWISE.EXE’.
System requirements

Windows 2000/ XP / Vista /7 /8 /8.1 /10 respectively 32 or 64 Bit

10 MB free hard disk capacity

A free serial interface (COM) for configuration, diagnosis and firmware update
Alternative: TCP/IP connection to the measurement setup for configuration and diagnosis
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Communication settings / communication

The UMB Configtool works in principle with connections to the measurement setup with
connection settings 19200 baud, 8 data bits, 1 stop bit, no parity. A different baud rate is only
possible by editing the file ULSPS.INI.

From UMB Configtool version 1.5 in addition to the direct serial connection to the
measurement setup a connection using TCP / IP is supported. The TCP / IP communication
is enabled in the UMB Configtool by setting ‘Edit’ ->' Use TCP / IP ' or in the “Configure
communication setttings” dialogue. The measurement setup is connected to an RS-232/RS-
485 to LAN / WLAN adapter (or similar device). The UMB Configtool supports the connection
to a host name or IPv4 address. Because TCP / IP connections as opposed to direct RS232
connections are affected by latency, an additional timeout has to be specified to wait for the
responses of the devices in the UMB-setup. The times given in the configuration dialog are
ms. For direct LAN connections to IP addresses, values of 100 (ms) are sufficient. For
example, targets with name resolution and GPRS connections require values up to 10000
(ms).

Note: Only the communication connection type ‘raw’ is currently supported (not Telnet
emulation).

Note: The set times are also considered for RS232 connections.
Note: Firmware updates are only supported over direct (vituelle) com ports, not over
direct TCP/IP connections.

@ Configure communication settings =AASAL X
Connection type
@) Use R5232 [COM)
Usze TCPAP
Hostadress or hostname R5232
192.168.129.13
Select Port COmM1
TCP-Port
8000
Additional Timeout for slow connections to host
1800 =
(] 3 Cancel
——

gy = Uﬁt G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 5
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For establishing a connection to UMB devices over the LCOM service program and LCOM,
the LCOM service program has to be started first and a connection to the LCOM has to be
made. Then the UMB Config Tool can be used with the following connection settings

o Connection type: Use TCP/IP

e Hostname: localhost

e TCP-Port: 8000 (when not changed in the LCOM service program)
to access the UMB devices connected to the LCOM.

Note: In the title of the UMB Config Tool the connection type is shown close to the program
name. If the connection is open, the connection is shown.

Connection type (port closed, TCP/IP connection)
@ UMB Config Tool - TCP/IP

| File Edit Options Help

Connection type (port open, TCP/IP connection)
@ UMB Config Tool - 192.168.129.13:8000

| File Edit Options Help

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 6
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Creating a sensor list

Menu: Edit > Sensors:

Station Sensors

Sensor Selection

Type of Sensor D
|vs20-uMe =l

Delete | M adify Configure |

Update Channellist | Firmwareupdate 5ensor |

=10l %]

Save/Exit |
Cancel/Exit |

Selected Sensors

D | Tupe Address Channelz

Active Channhelz

1 Y5 20-UME 0x3001=12283 |40

Click Sensor to edit/remove Sensar Double Click Sensar

Autozcan | Werify |

Save to Disk | Load from Disk. |

0

to edit active channels

Status 02.09.2015 version 2.5

Choose ,Type of Sensor’; enter an ID and add it with ,Add’ to the list. With ,Delete’ sensors
can be deleted, with ,Modify’ a sensor in the list can be modified. The sensor shown in
,Sensor Selection’ will be deleted or modified.

,Configure’ starts the configuration of the sensors in the list. ,Firmwareupdate Sensor’ starts
the module for updating the firmware of the selected sensor. ,Update Channellist’ reads the
channel list from the connected UMB-module / sensor and inserts new channels into the

existing channel list for this device.

Running ,Autoscan’ queries the network for existing UMB devices. ,Verify’ checks, if the

devices in the list are responding to communication from the master.

With ,Save to Disk’ the sensor list (including selected channels) can be stored for later reuse

(,Load to Disk’).

‘Lufft
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Configuring sensors

Status 02.09.2015 version 2.5

Select a sensor from the list by clicking it, then click ,Configure’. You will get the following

dialogue:

Sensor Configuration

Load profile from gensor

Load prafile from disk.

Store profile on sensar

Store profile on disk:

Load adj. data fram disk

Claze

Select senzor to configure

I 0x3001=12283 v l

=1o]

The check box "select sensor to configure" allows to switch to another sensor of the

measurement setup.

Load the configuration of the sensor with ,Load profile from sensor’. Adjust the values in the

mask to suit your needs.

Sensor Configuration

Main | Info  VS20UME |

General properties

D I =

Ivisibilit_l,l-sensor W520-UMB

Drezcriptian

Communication properties

Linespeed

Timeout protocal change

I 19200 - l
Protocol I binary j'

|5 vI [rriir]

o [=[ o

Output properties

Output mode

|4..20mA 'l
|2 3-
Scaling ID 2000 m 'l

Failure curent [mé)]

Measurement 5etup
Awerage for wvisibility [min]
Offzet for vizsibility [m]

Border contrast

Awerage for temperature [min]

Offset for temperature [*C]

Calibration values
DAL offzet £3.85248

DAC gain 163.11475

‘Lufft

Calibration walue

Calibration offzet

5201.97754

0.00033

Calibration status

Em—
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After the values have been set, store them on the device with ,Store profile on sensor’.

=l x|

Info | wS20UME |

Select sensor to configure

Load profile from senzor | I 0x3001=12289 Vl

Load profile from disk |

Store profile on sensor |

Store profile on disk. |

Load ad),. data from disk |

Cloze |

With ,Store profile on disk’ a sensor configuration might be stored on a hard drive. Stored
configurations of sensors might be loaded with ,Load profile from disk’.

Note: In case of a service call, a saved sensor configuration helps a lot more than one
or more screenshots of the sensor configuration.

GRS
‘Lufft
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Assigning device ID’s

Each device in a UMB network requires a unique address.

Status 02.09.2015 version 2.5

Addressing takes place via a 16 bit address. This is divided into a sensor class ID and a

device ID.

To avoid address duplication, the device ID’s are assigned in ascending order per sensor

class (i.e. sensor type):

Station Sensors

Sensor Selection

Tupe of Sensar
| ANACON-UMB

1D
=

Delete | fodify Configure

Update Channellist | Firmwareupdate Senzor

-loj x|

Save/Exit |
Cancel/Exit |

Selected Sensors

D | Tupe Addreas Channels

Active Channelz I

IRSZ1CON-UME | 0:10071=4037 2B
IRSZ1COM-UMB | 0x1002=4092 2B
IRSZ1CON-UME | 0x1003=4033 26
R25-UME 0x2001=8193 15
R25-UME 0x2002=8134 15
W5 20-UMBE 0x3001=12289 40
W520-UMB 0x3002=12230 40
AMACON-UMB  0:5001=24577 135
ANACOM-UMB | 046002-24573 135
AMNACON-UMB | 0:6003=24573 135
ANACOM-UMB | 046004=24580 135

e L3 B3 = R =R =Ly R =

Click Senzor to edit/remove 5ensor

Autoscan | Werify | Save to Disk |

Double Click Sensor to edit active channels

Load from Disk |

0

oo oo oo oo oo

ATTENTION: When configuring new equipment please note that new devices always have
the ID 1! If there are several sensors of the same type in a network it makes sense to
configure the sensors individually with their corresponding ID’s before commissioning the

network.

Interface settings

The interface settings made by the UMB Config Tool relate to the specified sensor.
Attention: Only change the interface settings if you are sure you have to, and if you
are aware of all the consequences of this change. This change may not be reversed in

a simple manner.

L
.S
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Configuring ANACON-UMB

As the ANACON-UMB is a universal measurement transmitter which can be operated with
various analogue sensors, this module must always be configured to the connected sensor
before commissioning.

To do this, connect the module to the power supply (with no additional participants on the
bus) and connect to the PC via an RS232 cable (1:1). Load the current configuration via
‘Load profile from Sensor’ as in the section ‘Configure Sensor’:

Select the connected sensor type in ‘Measurement Setup’ under ‘Channel 1’ and ‘Channel 2’:

Sensor Configuration ;lglﬂ
Main | Irfa Anacon-LMB |
General properties Communication properties
D | Linespeed RS232 120 =]
Description lm Pratocal I binary j'
Timeout protocal change 10 =

Meazsurement Setup

General Parameters  Channel 1 |Ehannel2|

Senzor bype Meazsurement categary Unit
j Itemperature |°C
= M ax value Offzet it Unit from Channel

j700 {0.000 | =
combi wind [3368.01] Overange [%] Sensor powerup time [ms]
combi wind 4., 20mé extern m m
combi wind 4. 20m intern x =z
air preszure [3355.03

Mumber of samples for average
|5 j |1 2 j Average over 60 3

Channel description
Ichannel 1

If necessary, set the ID, measurement interval and number of measurements for the min-,
max- and average values:

Meassurement intervall ] Mumber of zamples for average

j |1 2 j Aurerage over B0 2

Then save the amended configuration in the module with ‘Store profile on sensor’ under
‘Main’.

ATTENTION!! In the case of the temperature/humidity sensor (TFF 8160.TFF), the

values for C12 and C76, which are marked on the sensor head, must be recorded
under ‘General Parameters’!!!

General Parameters I Channel 1 | Channel 2|

Altitud: [m] 100 =

TFFC12 1625 = TFFC76 1956 2

o Ao

LR
B 8
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IRS31Pro-UMB and the mode IRS31-UMB compatibility

To configure an IRS31Pro-UMB for IRS31-UMB compatibility, you have to add an IRS31Pro-
UMB to your measurement setup and configure it.

Attention: Is the sensor programmed for IRS31-UMB compatibility, you have to add an
IRS31-UMB to you measurement setup with the corresponding id (for example to
guery measurement data or for sensor configuration). Is detected while reading the
configuration of a IRS31-UMB that the configuration is from an IRS31Pro-UMB in
compatibility mode, the configuration sheet of the IRS31Pro-UMB is shown, and the
compatibility mode cab be switched off.

Configuration of sensors operating in different protocols (e.g. MODBUS, SDI12)
If sensors are permanently set to protocols other than UMB (Binary or ASCII) they must be
changed first to the UMB protocol if you want to change the configuration with the UMB
Configtool.
The procedure for doing this is as follows:

1. Separate measurement setup from the supply voltage

2. Inthe UMB Configtool select 'Options' -> ‘Switch all sensors temporarily to UMB

protocol'

3. Connect the Measurement setup again to the supply voltage.

4. After about 5 seconds (or longer) click ,Exit' in the UMB Configtool
The sensors can now be configured for the time in minutes set under, timeout for protocol
change 'in the sensor settings by UMB Configtool. UMB telegrams e.g. Measurement
acquisition, configuration read / write reset the timeout to the time set. After a reset, the
sensor is running again in the configured protoco.
Note: After a ‘Store profile on Sensor’ the sensor is reset automatically by the UMB-
Configtool and then runs again in the configured protocol.

This functionality is available on the following products::

Sensor Firmware version or higher
ANACON-UMB Not available
ARS31-UMB Not available
ARS31pro-UMB Not available
DACONS8-UMB Not specified
IRS31-UMB Not available
IRS31Pro-UMB Version 1.0
Marwis-UMB Version 1.0
NIRS31-UMB Version 1.2
R2S-UMB Not available
VENTUS-UMB Version 1.6
VS20-UMB Not available
V200A-UMB Version 1.6
WSx-UMB Version 2.2

Query measurement values

The channel list of a sensor is opened by double clicking a sensor in the sensor list:

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany
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i |
@ Select active Channels SRR X

Chdr. teasurement Unit Range |active ‘ “ | Click on Charnel to toggle active
100 Act. temperature CH1 °C -200.00 .. 450,00 active Add channel from #
120 tin. temperature CH1 C -200.00 .. 45000 inactive 1 %
140 bax. temperature CH1 T 20000 45000 | inactive ’ﬂ;dd ghasls #m

. . €3]
160 Ay temperature CH1 C -200.00 .. 45000 inactive Dislta for channel
105 Act. temperature CH1 F 32800 . 842.00 Eactive : 1 %
125 Min. temperature CH1 F 3200084200 inactive Muliple channel action

@ Select channels

145 Maw. temperature CH1 F -328.00 .. 842.00 inactive Deselect channels
165 Ay temperature CH1 °F -328.00 . 84200 inactive Deselect all channels
1nm Act. temperature CH2 C -200.00 .. 450,00 inactive Go
121 tin. temperature CH2 C -200.00 .. 45000 inactive
1 Maw. temperature CH2 C -200.00 .. 450,00 inactive Ok
161 Ay, temperature CH2 T 200000 .. 450.00 inactive |Save [E——— || Load template|
106 Act. temperature CH2 F -328.00 .. 842.00 inactive
12R bin termneratire CH2 °F SAPRN0 R42 NN inartive %

Here you are able to select the channels for query, either through clicking the corresponding
channel in the list, or by using the “Multiple channel action” function with the channel
numbers.

Example:

If channels 100, 120, 140 and 160 of the list above should be selected for query with the
UMB Config Tool, this could be done with the following settings:

Add channel from #: 100

Add channel to #: 160

Delta for channel #: 20

Multiple channel action choose “Select channels” and then click on “Go”.

The active channels of the current sensor can be saved by “Save template” to a file. By using
“Load template” a previously saved list of active channels can be applied to a sensor with
any ID.

Note: If a channel mentioned in the operating instructions of a sensor is not shown in the
sensor list, the channel list of the UMB-Config-Tool for this sensor needs to be updated. It is
advised, that you update the Firmware of the sensor before updating the channel list (see
chapter Firmware Updates).

The measurement is started in menu ,File’ = ,Start measurement’.

Elconfig-Software-UMB - COM!1 - 19200 =10l=|

File Edit Cptions Help

AMNACON-UME 101 temperature ['C]Act | AMACON-UME 101 temperature [F]Act

AMACON-UME 1D1 relative humidity [%2]  |ANACON-UME D1 absolut humidity
Act [g/mF] At

21.27 70.29 36.40 770
.27 70.29 36.45 771
1.27 70.29 3645 772
.27 70.29 36.56 773
21.28 70.31 36.56 774
2126 027 3658 773
21.28 70.20 36.55 773
1.27 70.28 3653 774
.27 70.29 36.45 771
21.27 70.29 36.50 772

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 13
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To change the sampling rate of the software click ,Edit’ - ,Sampling Rate’. A sample rate of
1s does not correspond to the UMB-protocol. In the case of missing answers of the sensor it
can lead to erroneous presentation of the received values.

Attention: The selected channels only affect the data query in the UMB-Config-Tool. They
do not influence the query of channels in any other software.

Updating the channel list for a sensor

Add the desired sensor to the measurement setup and make it to the selected sensor (by
clicking the list entry).
o]

Sensor Selection

Type of Sensor [[]
[DaconsUMe =l
Save/Exit
sl | Dele | oy Configue | CancelEst |

Update Channellist | Firmwareupdate Sengor |

Selected Sensars

D IType IAddrass Channels Active Channels I
1 DACONE-UME  0-FO0T=E1441 O i0 H

Click Sersor to edit/remove Sensor Double Click Sensor to edit active channels

Autascan | Werify | Save to Disk | Load fram Disk. |

Then choose “Update Channellist”. The UMB-Config-Tool now reads the channels from the
desired sensor and sorts the new ones into the channellist. During this operation no channels
are deleted, but descriptions and other information of the old channels are replaced by the
newly read ones. Also the Type of Sensor might be changed during this operation. This
process also works for up to now unused sensortypes. However, such sensors cannot (jet)
be configured with the UMB-Config-Tool but querying measurement values works.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 14
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Firmware update

Before implementing any update, please check with Lufft concerning the current firmware
status of the UMB products. You must not program an older firmware into a module, than the
one which is currently installed without consulting Lufft over this issue.

Check current firmware status
The current status of the firmware should be checked before updating the firmware. To do

so, read the configuration under ‘SensorConfig’. The current version of the software is shown
under ‘Rev. firmware’ on the ‘Info’ page.

Ll ™

[ Main_| Tnfo" R2s-UMB |
Mame [Rzs-UME
Senialnumber |DEI1 (07060007000
Murrber a0y
Tested 0708
Project number DooF
Rev. bom ]
Rev. schematic |8
Rev. hardware |8

E Rev. fimwmare 4?)

Fev. config |‘IEI
Rev. device |DEIEI
Class-id 2

40 corresponds to Version V4.0

ul"t G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 15
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Program a sensor update

Before updating, save the current device firmware (mot file) in the installation directory under
‘Firmware’ (e.g. C:\Programme\Luff\UMB-Config\Firmware).

ATTENTION: When updating ANACON-UMB or IRS21CON-UMB, the RS232 connection
must be plugged directly into the module to be updated. Anacon-UMB and IRS21CON-UMB
with production date from February 2009 on can also be updated over the bus. ANACON-
UMB without frontside RS232 can only be updated over the bus. This requires at least one
ISOCON-UMB in the measurement setup.

ATTENTION: When updating a Marwis-UMB the program ,UMB_FWUpdate.exe® is used
instead of the program ,Hexload.exe“.Both programs are installed when you install the UMB
Config Tool in subdirectories of the installation directory of the UMB Config tools.

ISOCON-UMB have to be updated manually. The corresponding instructions can be found
the section "Updating manually with HexLoad"

Open the sensor list under ‘Edit’ > ‘Sensors’; if necessary, regenerate the list with ‘Autoscan’
or load a stored list with ‘Load from Disk’. With ‘Verify’, check whether the sensors available
in the sensor list are also reachable on the network.

_ioi x|
Sensaor Selection
Tvpe of Sensor [n]
Jvs20ume =l h
Sawve/Exit |
Add | Delete | Modify Configure | Cancel/Exit |
Update Channellist | Firmwareupdate Senzor |
Selected Sensars
[n] |T_l,lpe Address Channels Active Channels I
! WS2OUMB 0:3001=12289 |40 o
1 IRS21CON-UME | 0x1001=4037 26 0
1 ANACON-UMB  0=B001=24577 135 0
2 ANACON-UMB  Ow6002=24578 135 0
1 R25-UKE 0x2001=8193 15 0
Click Senzor to edit/remave Sensar Double Click Sensor to edit active channels
Autoscan | “Werify | Save ta Disk | Load from Disk |

Select the appropriate sensor from the sensor list; the selected sensor is displayed in the
‘Selected Sensors’ section (VS20-UMB in the example).

The update process is started with ‘Firmwareupdate Sensor’. The following window opens
when this function of the Config-Tool is used for the first time:

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 16
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Select path to Hexload-Program 21x1
Suchen in: IE}UMB-Eonfig j & i EEE
D ateiname: I j Qffnen I
Dateityp: IHeonad program j Abbrechen /l
i

Under ‘Hexload’, select the ‘HexLoad.exe’ file.

Status 02.09.2015 version 2.5

or
-
@ Select path to UMB firmware update program [UMB_F‘WU_ -
Suchenin: || UMB_FWlpdate - @& @
It= Mame ° Anderungsdatum Typ
""‘} [ L2P-UMB_FrameGenerator.exe 23.09.2014 08:47 Anwendung
Zuletzt besucht SR FiUpdate.exe 241020141106 Anwendung
L |
Desktop
Biblictheken
A
Computer
@' | i | ,
Metzwerk
Diateiname: UMEB_FWWlpdate exe -
Dateityp: [ IUME firmware update program

choose UMB_FWUpdate.exe in the folder UMB_FWUpdate.

After this (and on all future updates) a window opens in which you select the relevant mot file

for the update:

‘Lufft

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany
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Firmware to update current active sensor ﬂﬂ
Suchen in: IE} Firrmweare j = |‘j€ EZ-~

#*0007_RRS_Release_\42.mot
anacon_telease_\'11.mat
Frisocon_release W12 mak

nok

ung

Dateinanne: Ivs2El_reIease_V1B.mot j Offnen I
j Abbrechen |
F

Dateityp: I Firnware file

ul"t G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 18
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The device is then programmed:

Status 02.09.2015 version 2.5

JRI=TEq
File Edit Wiew Target Options MWindow Help
.ﬂ: Project ;Iglﬁl E-: Target ;Iglil
Hexfile: ¥520_RELEASE V16.MOT Range: E8B000 - FDFEF
COM Port: COM1 CRC: —
Baudrate: 19200 Application: BTL_V¥S20_¥3 Jun 6 2006 16:04:
CPU: M16C28 64pin
BTL Yersion BTL V3.00

&% Current data - [D:\PROGRAMME',LUFFT,UMB-CONFIG) FIRMWARE' ¥520_RELEASE V16 B[] B4
Address: [0+£8000 [ =2|

fiddress (B [1 [2 (3[4 [5[6 [? (8|2 |A[B[C[D]|E]|F]|[ASCII Iﬂ

EGAAB |(FC EF 7@ 95 18 85 6B FO P@ 96 C? B4 G4 F@ 78 C% ..p... .. ..... B

EgAil (2C B4 28 Fl epumrmerors o0 0 T _'x'.(...2 .........

EREZ0 24 7@ A8 63 Programming targek _| O D T a.

ESB3@ |1C F3 4C 46 ., . R P xh

EgB48 |9F @2 48 F4 [ R TP 1 |

EgB58 |68 6E 2h A2 n*.t. =..... =..

EgB6A |3C F& €A 5F 9% e eaeeaeamaan

EgA7A |94 @1 &8 F? = ho Tiooo.. e.d.

rgwge |8 98 50 61 | Poo... oo R

EgA?A |5C F?7 24 @§ I .0,

EEBAB |(F? @8 88 FA Cancel | R 4 B, P.

EgBEA (F@ 8% D1 BB 0000 — ] e e e e eaaas

EgBCA |'2C FC 94 &F AT TR | B

EgBDA (9D 898 A8 FD CA BE 2% B0 BC FE CA FD 8C 8@ 78 FE .............. p.

EEBEA [(AE 62 85 B8 D4 FE 48 37 VE B8 38 FF 26 76 77 88 _h....07".8._&vu.

EGAFA |2C FF 24 1A 71 B8 0@ 0@ EO 1D 6B 88 64 8@ 28 7C ..5.q..... k.d. <l

EGiPA |65 9@ C8 @@ CA 2F 6@ 8@ 2C A1 A8 33 5B 8@ 90 A1 e.... " ....3[...

E81i8 (A4 82 56 AF F4 81 A8 17 52 B 58 82 n6 ED 4D 8@ __U_____ R.H_..M.

Egi28 (BC 82 4C A 4n BA 28 B3 64 4B 46 @8 84 A3 B6 CA .. L.J. _dKF.__._.

Fi1130 47 AR F8& AT AR 70 IF GO 47 A4 78 L 3T AR BA A4 B =7 1. ¢ ﬂ

_|o| x|

CRC of loaded file: DIE4 ﬂ
Clear target started
Clear target succeed
Frogramming target started
[ 4
|Ready 5

For Marwis-UMB:

i ™
o 0 R

V011-5VN16eZ4\MRRWIS-UME RELEASE W11“MRRWIS BELERSE W1l S5VN1&Z7_BIN
Force-Flags set
Beboot-Flags set

Parsing passed

Starting Firmware Update. ..

Opening COMPort (COM1)

I Opening BinFile

l _BL-V011-S5VN1&6Z4'\MRRWIS-UMB RELEASE V1I\MARWIS RELEASE V11 SVN1&Z7_BIN)

ProjectHumber:1007; SWVersion:11l; Size:1Z1584Bytes

BinFile metadata:

Transfering data

After successful programming the Config-Tool reports as follows:

‘Lufft
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x

jj) Firmware update succeeded

The device then operates with the new firmware.

Possible sources of error

If a firmware is selected which does not correspond to the sensor, the error message
‘Invalid Firmware-Filename for this module’ is displayed.

When updating older ANACON-UMB or older IRS21CON-UMB, the RS232 connection
must be plugged directly into the module to be updated.

An ISOCON-UMB cannot be updated using this procedure (see page 25, Manual update
with HexLoad).

There is a plausibility check with the version number of the installed firmware, and the
version number of the firmware file. A replacement of a newer firmware on a sensor
with an older version is only allowed by a direct order from the manufacturer of the
module. If you don’t have the order, and the module is damaged by the action, the
warranty is void.

With Marwis-UMB manufactured before or in 11/2014 there is the possibility of an
incompatible firmware update protocol used by this program. Please contact then
the manufacturer hotline with the serial number of the sensor ready.

Resetting sensors to factory defaults

By choosing ,Options® — ,UMB Reset to factory default® in the main menu, UMB sensors and
modules can be reset to factory defaults.

-

L

@ UME reset to factory default l — | (5] |i3-r

ARS31 /AR5 31 Pro-UME *| Sensortype 1 & SenszorlD, O = Broadcast

| Reset Global Parameter to Factory default

| Reset Device Parameter to Factary default

For non ARS31-UME sensors check both boxes for UMEB-ChD 0x25 Function 0«11

| QK | Cancel

Attention: This function sets the Sensor-ID to the factory default ‘1’ as well!
When ‘Broadcast’ is used for Group-ID and “0” for the Sensor-ID, all connected
sensors are reset to factory defaults!

Since sensors do not answer on broadcast messages, this function does not deliver
feedback when executed.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 20
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Calibration of a VS20-UMB visibility sensor

Start by creating a sensor list, containing the VS20-UMB to adjust. Example:

Station Sensors

10| x|
Sensor Selection

Tupe of Sensor o]
[Fzs-uME =]
Save/Euxit |
Add | Delete | fodify Configure | Cancel/Exit |
Update Channellist | Firmwareupdate Sensor |

Selected Sensors

D |Type Address Channels Active Channelz I
1 R25-UMB 0x2001=8193 15 a
1 AMNACOMN-UME  026001=24577 135 a
1 WS20-UME 0x3001=12289 40 i

Click Senzor to edit/remove 5ensor Double Click Sensor to edit active channels

Autoscan | Werify | Save to Disk | Load from Disk |

Then chose ,Save/Exit’, ,Options’ > ,VS20-UMB Callibration’.
Run the calibration according to the description in the text field and like described in the
manual from the calibration kit. See picture below.

Etonfig—Software—UMB - COM1 - 19200
Eile. Edit Optiops  Help

=10l x]

r—Calibration Steps
| 0x3001=12289 =l
«
Calibration process VS20-UMB Start |
&7
Step 1
C3 Required items: Stop |
P 1x Calibration kit visibility (8366.UKAL1)
4
The calibration procedure will take about 10 minutes.
o0 ‘When the calibration process is interrupted, the ¥S20
will not measure until reset or power off.
(ol Press "Start" when you have all the equipment ready
and you want to proceed
L Press "Stop" to cancel
g
9
Scattering coefficient IEntel scattering coefficient here

‘Lufft
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Resetting the rain quantities of WSx-UMB

With the menu point 'Extras -> reset WSx-UMB rain sums' the absolute values of the rain
guantities in all connected WSx-UMB are set back to 0. It is not necessary to establish a
measurement setup with the WSx-UMB. It is however recommended to check if the
command has been carried out successfully by reading out the respective values on the
corresponding WSx-UMB.

Resetting the service level of NIRS31-UMB

After carrying out maintenance and replacing the reflector unit, the sensor must be informed
about this procedure using the UMB-Config-Tool.
In the menu under ‘Options’, select the entry ‘NIRS31-UMB’ — ‘NIRS31-UMB Service’:

@& UME Config Tool

File Edit | Options | Help

Switch all sensors ternporarily to UME Protocol

R5232 special functions
W520-UME Callibration
WSx-UMB reset rain

MIRS31-LUME » MNIRS31-UME Service
Close Communication Port MIR531-UME check adaption
ARS31(Pro)-UME Reset Factory Default MIR531-UME generate statusfile

Confirm the performance of maintenance with ‘OK’.
MIRS3L-UME Service (==

The following works were camied out according ta the manual:

[v reflector unit has been replaced

Cancel

Important note: Only use this function if maintenance was actually carried out and the
reflector unit was actually replaced.

Miscellaneous

,Edit’ a ,Password entry’ allows the user to change in a different user group with advanced
possibilities.

Parameters only adjustable by modifying the file ULSPS.INI:

[Settings]

LogToFile=1

Writes the measurement values into a log file, file name see ,LogFileName’. The column
headers are formatted GrouplD:ID:Channel (see table of measurement values).

LogFileName=Values.Txt
Basic file name for the log file. Will be expanded by the current date. The software creates a
new file for every new date.
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FTimestampsHaveMS=1
Timestamps for measurement data contain miliseconds, if this entry is missing or 0, the
resolution of timestamps are seconds.

CreateDayFiles=1
The registered values are stored in daily files. If the value is 0, they are all stored in one
single file.

MaxRetriesForProtocolWhenFailure=2
Number of retries per command, before a failure is reported.

AdditionalTimeoutinMSForSlowConnectionsToHost=0

Time in ms, which is waited additionally to the period of reply specified in the UMB protocol,
before for this instruction an Timeout is produced. The time specified in the protocol applies
to direct 1:1 communication. If the query is made e.g. by GPRS consider using 10000 (ms,
corresponds with 10s) here. Note: With 2 repetitions for each instruction (see
MaxRetriesForProtocolWhenFailure) it takes 3x10s = 30s, before this instruction is rated as
.Failed. Absolutely consider if an ,Autoscan’ is to be accomplished, and/or a measured value
guery is run with a short interval. This setting will be adjustable in the TCP/IP configuration
dialogue.

InifileVersion=2

Identifies the version of the ini-file format. Since Version 2 every sensor has its own section
in the file. [S1_0] is the section for the sensor with group-id 1. If this entry is not available, the
UMB Config Tool (version 2 or later) assumes an old ini-file version and tries to convert it into
the new structure. This will take about 1 — 2 minutes (depending on the computer).

AutoScanDeltaForFail=3

With ,Autoscan’ for each possible group by address 1 beginning ,a ,Verify’ command is sent.
If the device does not respond the next AutoScanDeltaForFail-1 addresses in ascending
order are queried with ,Verify'. The queried groups are 1 to 14 (group 0 is used for equipment
spreading broadcasts, group 15 are masters, here the software itself.

Example: Messurement setup with 1 device of group 2 Id 1 and 1 device of group 3 Id 2.
AutoScanDeltaForFail is set to 3.
List of queries (addresses, in Groupid:ld notation):

1:1 — Failed
1:2 — Failed
1:3 — Failed
2:1-0K

2:2 — Failed
2:3 — Failed
2:4 — Failed
3:1 - Failed
3:2-0K

3:3 — Failed
3:4 — Failed
3:5 — Failed
4:1 — Failed
4.2 — Failed
4:3 — Failed
5:1 — Failed
5:2 — Failed
5:3 — Failed

6:1 — Failed
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6:2 — Failed
6:3 — Failed
7:1 — Failed
7:2 — Failed
7:3 — Failed
8:1 — Failed
8:2 — Failed
8:3 — Failed
9:1 — Failed
9:2 — Failed
9:3 — Failed
10:1 — Failed
10:2 — Failed
10:3 — Failed
11:1 — Failed
11:2 — Failed
11:3 — Failed
12:1 — Failed
12:2 — Failed
12:3 — Failed
13:1 — Failed
13:2 — Failed
13:3 — Failed
14:1 — Failed
14:2 — Failed
14:3 — Failed

Thus 45 telegrams, in order to find the 2 devices (with this ID). Since every ,Failed’ is
repeated 2 times (default setting), that is altogether 131 queries. If now
AdditionalTimeoutinMSForSlowConnectionsToHost is set to 10s ,Autoscan’ takes about 25
minutes - so choose the parameters carefully if the ,Autoscan’ function is to be used.
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Manual update with HexLoad

The following procedure must be applied if a sensor update using the Config-Tool was
interrupted or in the case of an ISOCON-UMB.

Update ISOCON-UMB

Disconnect the power supply and the connected sensor from the ISOCON-UMB module
Connect the RS232 interface of the ISOCON-UMB module to the PC

Start HexLoad (...\Programme\Luff\UMB-Config\Hexload\HexLoad.exe)

Load the current mot file with ‘File’ > ‘Open’. This must (!!!) have the file designation
‘isocon_release_Vxx.mot’, where ‘xx’ specifies the version number.

Switch on the power supply of the ISOCON-UMB module.

‘BTL_ISOCON_Vx...." must now be displayed in HexLoad in the ‘Target’ window next to
‘Application’.

A HexlLoad ¥3.00j -0 =l

File Edit Wiew Target Options Mindow Help

PN PE

o g

7, Praject =00 =10l
Hexdile: x 12.mot Range: EB000 - FDFEF

CRC: —

COM Port: .
Baudrate: 19200 Application: BTL_ISOCON %1 Jun 6 2006 15:5
CPLU: W1 [0 0 odpin

BTL ¥ersion BTL ¥3.00

% Current data - [N:\PROJEKTE,0509 ISOC o ] 5
addess: [0:E8000  [ul 2|

[Address (@ [1 [2[3[4[5]6 (7 [8[9 [A[B|C|D]|E]F[ASCII |i|
" FRAAA (2D 2D 2D 2D 2A 49 R 4F 43 4F 4F 2R 2D 2D 2D 2D ——— TROCON ———

7. Start the programming with F9.
8. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
9. The module is now ready for operation with the new firmware.

Manual update of IRS21CON-UMB
If it is necessary to update an ISR21CON-UMB module manually, proceed as in the case of

‘Update ISOCON-UMB’, where the name of the mot file must correspond to
‘IRS21con_Vx_x.mot’.

9§
Lufft -
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Manual update of VS20-UMB, R2S-UMB and other UMB-Sensors

1. Disconnect the power supply of the sensor from the ISOCON-UMB
2. Switch on the power supply of the ISOCON-UMB module
3. Connect the RS232 interface of the ISOCON-UMB module to the PC
4. Start HexLoad (...\Programme\Lufft\tUMB-Config\Hexload\HexLoad.exe)
5. Load the current mot file with ‘File’ = ‘Open’. The file must (!!!) have the following
designation, where ‘xx’ specifies the version number.
o VS20-UMB: ‘vs20_release_Vxx.mot’
e R2S-UMB: ‘R2S_Release_Vxx.mot’
o WSx-UMB: 'WSx_Release_Vxx.mot’
o |RS31-UMB: IRS31_Vxxx.mot’
¢ ARS31-UMB: ‘ARS31_Vxx.mot’
e VENTUS-UMB: ‘Ventus_Vxx.mot’
e V200A-UMB "Ventus_Vxx.mot’ (!)
¢ NIRS-UMB: ‘NIRS_Release_Vxx.mot’
6. Connect the power supply of the sensor to the ISOCON-UMB module.
7. The following test must now be displayed in HexLoad in the ‘Target’ window next to
‘Application’:
e VS20-UMB: ,BTL_VS20 V...
Hexdile: y .mot Range: EB000 - FDFEF
COM Port: : CRC:

Baudrate: 19200 ApplicationC_BTL_¥S20_V3 IDh 6 2006 16:04:
CPU: ATECIZE-E T
BTL ¥ersion BTL ¥3.00

e R2S-UMB: BTL R2S V...
JRI=TET JR=TEY
Hexfile: V8. mot Range: ES000 - FDFEF
COM Port: Crivied CRC:
Baudrate: 19200 Applications 3 2006 09:44:5

CPU: Sai
BTL Yersion BTL V3.00

8. Start the programming with F9.
9. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
10. The module is now ready for operation with the new firmware.

(W
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Additional information

Details on the sensor configuration are described in the sensors instruction manual.

Details on the UMB-protocol specification including UMB error codes are found in the “UMB
Protocol”. All these documents are available on www.lufft.com in the section support —
download — manuals — UMB-Technology.

G. Lufft Mess- und Regeltechnik GmbH

GutenbergstralRe 20
70736 Fellbach

PO Box 4252
70719 Fellbach
Germany

Phone: +49 711 51822-0
Hotline: +49 711 51822-52
Fax: +49 711 51822-41

E-mail: info@lufft.de
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